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2008-09-16 (6.0.0.684-2) Translation updates (Italian, Spanish, Portuguese). Support for macro in watermark text. Support for pdftk in superimpose operations. Fix: RunOnErrorDir was ignored and the RunOnError was set as default dir. Freeware license was limited to 10 users. Just follow the few steps listed here: When the setup has completed you
will have a printer called PDF Writer. To check for updates, choose Help > Updates in Bridge. PDF compatibility level changed from 1.4 to 1.6. 2007-06-04 (3.0.0.222) Printing dialog now captures focus on Windows Vista. Defaults to 300 DPI instead of 600 DPI for smaller output files. 2009-01-26 (6.0.0.744) New gslite.exe distribution to fix
performance problems on Citrix installations where the C drive is a mapped client drive. 2008-03-26 (4.0.0.570) New experimental settings (hidetabs, hidecontrols, disablecontrols). If you have created aliases for the original Adobe Output Module files and folders on Mac OS X, ensure that you are copying the original files and folders. New devices are
pswrite and psraw. Fix: In the previous version some jobs would lock the print spooler queue. AllowExecute setting added to the registry to improve security. Fix for background syntax. New setting watermarkfontsize is now supported. Support for both Microsoft.NET Framework 2.0 and 4.0. Updated translations. Support for Windows 2003 x64 (64
bit edition). Unicode messages supported. This extends the programmatic control you have over the PDF Writer. 2015-05-11 (10.12.0.2363) Fix to disable image compression with commercial distiller. Do you want to enable it now?" Click Yes. 2007-04-09 (3.0.0.174) The printer has been localized to Portuguese (Brazil). New /SourceDir setup
prarameter. 2012-10-09 (9.1.0.1454) New PrinterVersion property in PdfSettings API. macro no longer contains the directory part. 2007-08-23 (3.0.0.310) Fix: Setup program of version 3.0.0.309 was not compressed. GUITimeout defaults to 0 for better performance on multi user systems. This has now been fixed. 2017-08-22 (11.3.0.2668) Updated
translation for Portuguese (Brazil). 2012-11-05 (9.2.0.1499) Max size of custom pages was increased to 1000 by 1000 inches. *Note: Bridge CC 6.2 is not supported on Mac OS X 10.8 or earlier. To decompress the downloaded file, double-click it. Support for Scandinavian characters in watermarks. 2014-03-21 (10.4.0.2240) Context menus now
support Unicode. Installs on Windows Server 2016 Preview 4. New settings: SignThumbprint, SignStoreName, and SignStoreLocation. 2015-06-16 (10.13.0.2368) Fix for uninstalling program specific event log. TempFolder registry setting added for control of temporary folder for the printer port. With this setting you can specify which license to use.
Translation updates (Catalan). New setup command line switch USEDOTNET20 to force the use of Microsoft.NET 2.0. Remember last used option set with support for hidden dialogs. Improved encoding of the PDF property values such as title and author. 2007-05-18 (3.0.0.209) Use of /NOICONS during silent install will not install icons in start menu,
desktop, and quick launch. New setting watermarkhorizontaladjustment is now supported. It now removes additional Microsoft Office extensions. Use ConfirmOverwrite=no if you want to overwrite the destination file without a prompt. New macro to force empty fields such as author and title. Creates output folder if it doesn't exist. New macro tag
added. Suppress errors when running in non interactive mode such as service accounts. Supported PDF Power Tool version is now 3.0.0.6 or later. A new file name macro was added to remove strings like "Microsoft Word -" from the document title. 2018-10-08 (11.8.0.2728) Added feature for remembering recent save locations. PrinterName context
variable added for VBS macros. Fix of error when output format is different from PDF and encryption was enabled. Ignores missing merge files when controlled via runonce.ini. 2013-09-26 (10.0.0.1840) Greatly enhanced Unicode support in user interface. Improved uninstall routine for cleaner uninstall. New setting watermarkverticaladjustment is
now supported. Settings RunOnSuccess, RunOnSuccessDir, RunOnError, RunOnErrorDir, AfterPrintProgram, AfterPrintProgramDir and StatusFile now support macro substitution. Fix for Corel Essentials 2020 compatibility. 2007-05-08 (3.0.0.201) New printer driver (PPD file) More paper types supported (Letter, Ledger, Legal, A3, A4, A5, 11x17,
Note, A2, A6, LetterSmall, A0, A1, A4Small, A7, A8, A9, A10, ISO B0, ISO B1, ISO B2, ISO B3, ISO B4, ISO B5, ISO B6, JIS B0, JIS B1, JIS B2, JIS B3, JIS B4, JIS B5, JIS , 6, C0, C1, C2, C3, C4, C5, C6, ARCHE, ARCHD, ARCHC, ARCHB, ARCHA, FLSA, FLSE, HalfLetter, PA4, and Custom Page Sizes) Specify PDF Settings (color model, image
compression, compatibility, auto rotate pages, embedded fonts, subset fonts, and page compression) Placing a file named debug.txt in the program folder will set the program in debug mode. New settings RunOnSuccessMode, RunOnErrorMode, and AfterPrintProgramMode. 2007-03-25 (3.0.0.164) The printer has been localized to German and
Danish. Serbian added as new language. 2009-12-25 (7.1.0.1082) Fix of error 429 when using ActiveX object 'BioPdf.PdfWriter.Xmp' on 64 bit systems. Fix for systems with multiple copies of the same font. Setup can now distribute content to the special folders 'Application Data', 'Common Application Data', and 'Local Application Data'. Support for
the macro in the PDF output file name. Copy the AdobeOutputModule.workspace file into the Workspaces folder under the Bridge Extensions folder (the same folder referenced in step 2). Microsoft.NET Framework 2.0 was discontinued. 2008-10-21 (6.0.0.695) VBScript macros and events are now supported. You don't need to install Adobe Output
Module separately. Advanced customization feature where you can replace the GUI with your own executable file made in your favorite programming language. The Adobe Output Module (AOM) plug-in (explained in this article) is no longer supported and the functionality to create web galleries has been discontinued in the latest version of Bridge.
New AfterPrintProgram setting in configuration files. New installer switch: PostScriptLanguageLevel to control the language level of the driver. MSI package changed to preserve the default printer and suppress message boxes. Japanese translation completed. Fixed Thai translation. However, you can install it separately. Dependency of
Scripting.FileSystemObject has been removed. 2007-12-17 (4.0.0.456) Automatic download and installation of Ghostscript Lite distribution. Unicode output file names support when running witout GUI. Advanced option dialog with buttons to edit global.ini, print a test page, and more. 2005-11-20 (1.0.0.10-2) Setup now also support Windows 2000 and
2003. 2014-02-18 (10.3.0.2191) New PDF command line tool for merging and printing PDF documents. Malay language was added. More paper sizes added. New Feature: 40 bit and 128 bit password encryption. 2006-12-03 (2.0.0.22) Support for Windows Vista. The specified port is unknown. 2018-01-29 (11.5.0.2698) Open an email with the new PDF
attached. Fix for commercial distiller PPD to enhance compatibility. 2018-05-06 (11.7.0.2716) Fixes setup issues. Installation and unstallation now supports multiple instances of the program installed on the same computer. 2006-12-11 (2.0.0.24) 2006-12-07 (2.0.0.23) Support for Windows Vista x64 (64 bit edition). 2007-02-10 (3.0.0.25) No
compatibility with older versions! Graphical user interface added. Experimental support for PDF/A-3b format. Fixes installation error: Operation could not be completed (error 0x00000704). There was a problem with the notation such as when used together with the pdftk.exe 2010-09-28 (7.1.0.1218) Support for Ghostscript 9.00 Fix for runtime error
438 when the file name field in settings.ini is empty. New installer switch: PostScriptOutputOption to control the output options of the driver. Changes in license file. Problem with installing olepro32.dll on Vista should be fixed. 2014-05-06 (10.5.0.2262) FIPS compliant. Fix for error 429 on some computers. 2008-09-18 (6.0.0.684-4) Translation
updates (Russian, Japanese, Portuguese). Image compression setting can be changed from the user interface. Font compression enabled for PDF/A to reduce file size. To copy the original file or folder the alias points to, right-click or Control-click the alias file/folder and choose Show Original from the context menu. Fix for Word document creation on
64 bit systems. Registration of msscript.ocx during installation was moved to 64-bit context when possible to avoid access error (0x5) problems. 2017-09-03 (11.4.0.2674) Abort print job if user in not interactive and dialogs should be shown. 2007-11-14 (4.0.0.408) New Feature: Remember last used folder name. Multiple printers can be installed using
the /PRINTERNAME="Printer1,Printer2" setup command line switch. 2013-02-19 (9.4.0.1570) Improved quality and file size in superimpose operations. Support for Windows Terminal Server. New DisableOptionDialog setting in configuration files. 2012-12-05 (9.3.0.1516) Change user interface language for specific users. New feature: Create
linearized PDF files for optimized web viewing. 2007-10-07 (3.0.0.332) Improved memory handling when printing large documents. Default PDF/A color space changed to RGB. However, it is important that you install all three. New setting watermarkfontname is now supported. In the dialog that appears, copy and paste this path: /Library/Application
Support/Adobe/Bridge CC 2017 Extensions Click the Go button. New setup command line switches GSLiteURL and GSLiteDownloadMode. Support for 64 bit Ghostscript 9.01. Problem where the installer reported "Not implemented" has been fixed. Access Adobe Output Module in Adobe Bridge You can access the Output Module two ways after you
install it: In Bridge, choose Window > Workspace > Output. 2007-09-26 (3.0.0.323) Discards abandoned jobs for improved stability on Citrix. The home page icon will not be installed in the start menu when this parameter is specified. COM/ActiveX interface for programmatic control was added. Requires latest gslite 8.64 or full Ghostscript 8.64 or
later. UNC roots are now valid destinations. Translations added (Norwegian - nynorsk). Translation updates: Polish, Slovak. Support for XPS based printer drivers as an alternative to Postscript. Runtime error 380 should no longer occur during startup. New setting: ExtractText. New AfterPrintProgramDir setting in configuration files. Turkish added
as new language. This enables you to select between sets of preconfigured settings when you create your PDF documents. 2007-11-19 (4.0.0.412) The settings UseDefaultAuthor and UseDefaultTitle now defaults to no. Copy the AdobeOutputModule.workspace file into the Workspaces folder under the Bridge CC 2017 Extensions folder (the same
folder referenced in step 2). 2009-11-10 (7.1.0.1007) Improved handling of Unicode document titles. Security updates. Uninstall only removes printers where the AppFolder registry value matches the application folder being uninstalled. New Merge function in API that supports font embedding. 2020-02-09 (11.12.0.2816) Fix for Chrome version 80
postscript bug. 2008-03-21 (4.0.0.568) Version number is written to printer comment field during installation. Simplified Chinese as new language. If no global@printername.ini file is found it will fall back to search for global.ini.
Workaround Manually drag up or drag down the window. Updated translations. 2008-07-14 (6.0.0.641) Major version
changed from 5 to 6. Fix: The previous version could only detect Ghostscript 8.54. Japanese language added. 2007-06-01 (3.0.0.215) Forces target settings to lower case. 2011-09-14 (7.2.0.1317) GSLite updated to version 9.04. New Feature: Access permissions. An alias is a file that links to the actual item. Bug Radar removed from Windows 8 Start
Menu. Install the Adobe Output Module for Bridge CC 6.2 If you are using the earlier version 6.2 of Bridge CC, download the appropriate AOM package file below by right-clicking (Windows) or Ctrl+clicking (Mac OS) and choosing to save the file. Translation updates (Estonian, Vietnamese) Registry value
HKEY_LOCAL_MACHINE\SOFTWARE\Bullzip\PDF Printer\Settings\GhostscriptFolder is no longer added by the setup program when it installs Ghostscript. New settings: res, resx, resy, textalphabits, graphicsalphabits, device, and statusfile. Commercial Distiller If you are using the special edition with the commercial distiller included in the installer,
you can download the latest version here. Translation updates (Swedish, Norwegian). Contents of an App folder placed next to the setup program is copied to the program folder during installation. For that you need a set of MSI packages. You can download the appropriate AOM file using the links provided in this article. Setting suppresserrors is
default set to no. *Note: Bridge CC 2015 version 6.3 is not supported on Mac OS X 10.8 or earlier. To decompress the downloaded file, double-click it. 2009-05-04 (6.0.0.865) Experimental support for PDF/A-1b document standard. The folder contents reside in a different location and need to be moved to the correct folder. The installation of this
program is very simple. Writes a job.ini file with print job information in the printer's temp folder. To navigate to the Bridge CC 2015 Extensions folder on your Mac: In the Finder window, choose Go > Go to Folder. Fix: Open PDF documents after printing. Commercial distiller now uses Flate image compression by default. Click here to download
Ghostscript Lite Offline Installation You can also install the program and the required components when you are in an offline environment. Color problem when printing red on Windows XP has been fixed. 2007-02-20 (3.0.0.129) Feature: The config.exe utility now supports /C that will remove all settings. New experimental PdfUtil.PrintPdf function in
API. 2006-01-25 (1.0.0.17) Users no longer need admin privileges in order to use the printer driver. Try one or more of these solutions: Solution 1 - Reset the workspace In Bridge, choose Window > Workspace > Reset Workspace. Now supports re-distilling of encrypted PDF documents. New feature: Show list of page thumb nail images when opening
the PDF. Multiple mail attachments. 2008-02-12 (4.0.0.543) "Save As" dialog shows in front of the printing application in Windows Vista. GUI.EXE parameter names are no longer case sensitive. New Feature: PDF Watermarks/stamps can now be placed both over and under the normal print. Supported Ghostscript version is now 9.10 or later. New
macro creates a random string of 10 letters and numbers. It is distributed under the GNU General Public License. 2007-07-25 (3.0.0.275) Improvements to Citrix installation to avoid the "The arguments are invalid" message. Swedish added as new language. New setting watermarkhorizontalposition is now supported. Support for commercial distiller
on file systems without short names. Belarusian translation added. 2008-03-03 (4.0.0.549) Translations updated (Spanish, Slovak). Translations updated (Czech, Finnish, Galician, Simplified Chinese). Fix for reading Unicode postscript properties written using octal numbers on Windows 2000. Shows printer window in task bar. New context value
AppPath when running VB Script macros. Fix: The config.exe utility reported an error when setting values. New Feature: PDF Watermarks/stamps can use different colors, fonts and outline style. AfterPrintProgram is now run in case of success. Normally the setup program will download the required components from the Internet. Improvement: The
output setting can be used to specify a default folder. In the dialog that appears, copy and paste this path: /Library/Application Support/Adobe/Bridge CC 2015 Extensions Click the Go button. Open the resulting AOM_Mac, AOM_Win64, or AOM_Win32 folder. 2015-08-31 (10.20.0.2459) Fix for a false positive detection in Norton AV. Instances are now
recognized by the options dialog. New Creator setting to set Application property in the PDF. 2008-02-21 (4.0.0.545) Translations added (Ukrainian, Korean). Register assemblies for use with Visual Studio 2010. 2007-07-28 (3.0.0.278) Support for file systems without support for 8.3 representation of long file names. 2013-03-28 (9.7.0.1592) More
robust installer that handles problem when HP drivers are not installing correctly (error 0x00000002). Cleanup of failed print jobs. FIPS compliance detection added for new operating systems. 2009-02-22 (6.0.0.766) Support for Adobe Normalizer as document converter instead of Ghostscript. Use the link below in case you want to download it
manually. Advanced printer setting 'ICM Method' now defaults to 'ICM Disabled'. Default RunOnSuccessMode, RunOnErrorMode, and AfterprintProgramMode changed from Hide to Normal. Portuguese (Brazil) translation completed. Polish language added. 2017-01-15 (11.0.0.2588) Document Collector program added to help merge documents. Open
the resulting AOM_Mac_New, AOM_Package_Win64, or AOM_Package_Win32 folder. Version History Version history RSS Feed 2021-03-09 (12.2.0.2902) 2021-03-01 (12.2.0.2893) Options dialog now works for printers with custom port names. Support Windows 2000 was discontinued. Updated translations (Czech, Arabic, Japanese, Russian,
Ukrainian, Turkish, Spanish, Catalan, Korean) 2010-03-21 (7.1.0.1181) New job specific runonce files of the form runonce_documentname.ini. New setting 'format' is used to specify pdfa1b when creating PDF/A-1b documents. Handles error where a configuration with an encrypted password is moved to another machine. New setting to change the
ICC profile for smaller PDF/A-1b documents. Ignore empty registry settings. Support for setting signature on the last page. Administrators can now use the printer on a remote connection without a professional license. MSI Package You can install the PDF Writer using Group Policy Objects (GPO) under Active Directory. New function
GetWindowsDefaultPrinterName in PdfUtil API assembly. Translations updated (Arabic, Greek, Portuguese-Brazil). 2014-09-03 (10.8.0.2282) Fix of possible deadlock when reading error output from programs. Acrobat User Guide Introduction to Acrobat Workspace Creating PDFs Editing PDFs Scan and OCR Forms Combining files Sharing, reviews,
and commenting Saving and exporting PDFs Security Electronic signatures Printing Accessibility, tags, and reflow Searching and indexing Creating PDF indexes Searching PDFs Multimedia and 3D models Print production tools (Acrobat Pro) Preflight (Acrobat Pro) Color management The Adobe Output Module (AOM) is an optional plug-in that you
use with Adobe Bridge to create PDF presentations and web galleries. The next time you launch Bridge, the following warning appears: "The Bridge extension 'AdobeOutputModule' has been added to Bridge. Better cleanup during uninstall. New setting: MacroDir. 2007-04-09 (3.0.0.181) Fix: Maximize button disabled in options dialog. Support for
Windows 8 Consumer Preview was removed. CONFIG is no longer depending on the missing MFC71.DLL. Offline installation requires that you download the following files and place them in the same folder: PDF Writer setup Ghostscript Lite setup Xpdf setup PDF Power Tool setup When you run the PDF Writer setup from that folder, it will see the
other installers and install them from there instead of downloading them. Bridge CC 2017 is not supported on Mac OS X 10.9 or earlier. More Unicode stuff. 2018-04-12 (11.6.0.2714) Select PDF/A-2b and PDF/A-3b from user interface. Solution 2 - Manually reset the workspace Windows: Close Bridge. Fix: Merging with a file that doesn't exist does no
longer create an empty PDF file. New Feature: PDF Watermarks/stamps can be placed anywhere on the page. New MacroAllowUI setting to control the display of message boxes when running VB Script macros. With this you can superimpose on print jobs from Internet Explorer and Firefox. 2006-09-22 (1.0.0.20) Fix: Reads Author, CreationDate,
Creator, Keywords, ModDate, Subject, Target and Title form settings.ini. Improved uninstaller. Improved Unicode support. This provides better Unicode support. To decompress the downloaded file, double-click it. Tab order fixed. Path to status file can now be passed as %4 to programs used in 'AfterPrintProgram', 'RunOnSuccess', and 'RunOnError'.
New setting watermarkoutlinewidth is now supported. Updated translations (Japanese, Afrikaans, German, Hebrew, Slovak, Swedish, Dutch, Russian, Danish, Bulgarian, Norwegian, Brazilian Portuguese, Simplified Chinese, Slovenian). Fix for periodical Ghostscript error. 2017-08-20 (11.2.0.2667) Runonce configuration files are now picked up as
soon as the spooler starts spooling print job to the printer port. This allows installation of multiple printers running with different settings. This will split the resulting PDF document into one file per page. Progress indicator is now shown it the system tray. Ghostscript is an open source program that is able to convert PostScript to PDF files. 2008-0120 (4.0.0.463-6) Translations updated (Dutch, Indonesian, Polish). 2007-05-22 (3.0.0.210) Spanish added as new language. New Feature: Watermarks. Minor tweaks. 2020-03-04 (11.13.0.2823) New macro to get name of the originating computer in a shared printer installation. 2007-08-09 (3.0.0.290) Experimental support for named instances of the
printer. New setting watermarkverticalposition is now supported. It will control the PDF compatibility level. Shows messages and SaveAs dialogs in the user's context. When you move the alias for an item, the original item doesn’t move. /noghostscript parameter for setup program will skip the check for Ghostscript. New Feature: Set document
properties. 2007-11-21 (4.0.0.419) Fix for dialog sizes on remote desktop connections. Settings are no longer written to registry. Delete the !!-$$$AdobeOutputModule.workspace file. 2008-05-06 (5.0.0.599) Multiple /PRINTERNAME can be specified during setup to install more than one printer. New macro tags: , , and . Shell execute mode support
for RunOnSuccess, RunOnError, and AfterPrintProgram. Fix for start and end page when sending a PDF to a printer. In theory this should improve the support on Terminal Server and Citrix. Translation updates (Estonian, Simplified Chinese, Spanish, Finnish). Updated translations: Swedish, Slovenian, Urdu 2014-12-02 (10.10.0.2307) Handles
PostScript jobs larger than 2GB. fixes. Translations updated (Norwegian - bokmål). Merge operation allows Postscript files as input in addition to PDF files. New setting 'AutoRotatePages' to control automatic page orientation. This requires that you are the owner of the content. New settings supported: showprogress, showprogressfinished,
runonerror, runonerrordir, runonsuccess, and runonsuccessdir. Hindi language was added. 2008-05-13 (5.0.0.609) Correction of "Error 53: File not found" during cleanup in temporary files. Registry value HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Print\Printers\Bullzip PDF Printer\AppFolder is now written to associate the
installed printer with a specific program folder. Now uses ps2write device for PostScript generation with Ghostscript. New setting: LicenseFile. In the dialog that appears, copy and paste this path: /Library/Application Support/Adobe/Bridge CC Extensions Click the Go button. Lists only local printers when running the options dialog. If you have
created aliases for the original Adobe Output Module files and folders on Mac OS X, ensure that you are copying the original files and folders. New setting watermarkcolor is now supported. In Finder, navigate to the Users/[user name]/Library/Application Support/Adobe/Bridge CC 2017/Workspaces folder Delete the !!$$$AdobeOutputModule.workspace file. Send mail via SMTP. more... 2008-01-21 (4.0.0.463-7) Translations updated (Norwegian, Traditional Chinese). To resolve this issue, download the latest AOM files for Mac OS available in the section Install the Adobe Output Module and replace the existing files with the latest ones. Fix: Earlier versions could

sometimes remove custom defined paper sizes for other printers during installation. 2007-02-28 (3.0.0.133) Fix: Removed dependency for Windows Scripting Host version 5.5. Fix: Spelling errors. Append to the output file if it already exists. Fix: The RunOnError command line is now executed if a macro raises an error. Built using Visual Studio 2012.
Fix for hiding run action error dialog in silent mode. 2008-09-26 (6.0.0.690) Multi merge feature released. Default ICC color profile was changed for PDF/A-1b compatibility. Print encrypted documents. Additional registry cleanup in uninstaller. MessageCode and MessageText added in the status file. Split function added to the API. New FastTrack
setting for fast image creation. Balloon tip notification when the PDF is created. 2008-01-15 (4.0.0.463-4) Translations updated (Turkish, Latvian). Fix of problem with the Save As dialog. Digitally sign PDF files using certificates in the certificate store. Fix: Minor change in watermark routine. Fixes problems in some Vista installations. Escaping of
characters fixed for job specific runonce file naming. Option dialog now supports FTP, and SFTP uploads. New Feature: Open destination folder after PDF creation. Translations updated (Korean). 2012-01-02 (7.2.0.1338) Works with Windows 8 (Developers Preview). New setting rememberlastfoldername is now supported. New options dialog tabs for
file upload, running programs, and signing with digital certificates. Text extraction was improved. GUITimeout setting -1 problem fixed by keeping the document collector running until the GUI has finished processing the job. AES 128 bit encryption is now supported with the commercial distiller. Override port log file folder with registry setting.
Support for attaching files inside the PDF document. By default the watermark will now behave as a stamp and be placed on top of the print. Translation updates. Setup will default to paper size A4 unless the locale indicates USA or Canada. New setup command line switch /PRESERVEDEFAULTPRINTER. Valid values are 1.1, 1.2, 1.3, 1.4, and 1.5.
This setting can also be controlled from the GUI. Problems with installing msxml6.dll have been fixed. Improved support for file names with regional characters in the Merge function. Farsi language was added. This text can be parsed and values can be extracted and used as macros such as author or title. New macro. Other translations were
updated. This enables the use of PDF stamping the PDF files. Russian and Hungarian added as new languages. Setting usedefaulttitle is default set to yes. Copy the AdobeOutputModule.workspace file into the Workspaces folder under the Bridge CC 2015 Extensions folder (the same folder referenced in step 2). This controls where the VBScript
macros and event handlers are loaded from. User's current selection of folder and file name are now saved in user.ini. New optionset macro name. One MSI package for both silent and non-silent installation. Option dialog now supports running programs on success and error. New GhostscriptTimeout setting in configuration files. 2007-08-24
(3.0.0.313) Fix: Uninstall no longer removes additional printers. Unicode font support brought back to previous level. Fix for size of background PDF when running as a shared network printer. Introduction of global.ini. 2010-09-18 (7.1.0.1212) New MacroScriptTimeout setting to control the script timeout when running VB Script macros. Slovak
language added. Handle warnings that appear When you add files to the Bridge Extensions folder, you see the warning: "The item 'Adobe Output Module' can't be moved because 'Bridge Extensions' can't be modified." Click Authenticate, and then enter your administrative user name and password. 2008-08-10 (6.0.0.659) New compatibilitylevel
setting. Advanced features of Postscript driver were disabled to fix left to right (LTR) printing issues. Commercial distiller uses standard encoded fonts. Security, Zoom, and UseThumbs settings now also work when merging documents. Produces smaller PDF/A documents. 2008-07-18 (6.0.0.648) Superimpose on top of printout is now supported. 200804-09 (5.0.0.590) Ini files are now coupled to the printer name. COM API method Merge2 added to supported merging from VB Script. Support for Ghostscript 9.10. Use "general" PPD setting in printing dialog. New hideoptiontabs setting to control which tabs are visible in the options dialog. 2015-09-03 (10.21.0.2462) Another false positive detection
in Norton AV and Symantech EndPoint. This folder contains: The Adobe Output Module folder The AdobeOutputModule.workspace file Copy the Adobe Output Module folder (not the AOM_Package_[OS] folder) into the Bridge CC 2017 Extensions folder in the appropriate location: Windows: C:\Program Files\Common Files\Adobe\Bridge CC 2017
Extensions macOS: /Library/Application Support/Adobe/Bridge CC 2017 Extensions In the macOS folder path mentioned above, "Library" refers to the System Library, not the User Library on macOS. Translations updated (Afrikaans, Russian). Updated translations (Swedish, Norwegian, Dutch, Afrikaans, Spanish, Finnish, Croatian, German,
Portuguese - Brazil, Portuguese - Portugal, Greek, Slovenian, Indonesian, Polish, French, Turkish, Chinese - simplified, Chinese - traditional, Italian). Adobe Output Module for Bridge CC 2018 version 8.0 Beginning with the October 2017 release of Bridge CC, the following updates have been made: A new Output workspace has been introduced to
generate PDF contact sheet natively in Bridge. 2006-08-28 (1.0.0.19) New Feature: Output quality control. New setting 'icc' to specify color profile for PDF/A creation. Fix for not remembering the last output device. macro now strips file extensions of 4 or less characters. Supports hard coded license levels in redistribution builds. Fix for Korean
Unicode license decoding. GUI encrypts owner and user passwords in configuration files. Works with United States Federal Information Processing Standard (FIPS) validation enabled. If it is missing it will download and install it for you. Translation updates (Afrikaans, Croatian, Estonian, Hebrew, Slovak, Turkish). 2015-08-21 (10.16.0.2426)
Uninstallation of Xpdf fixed. Compatibility with Ghostscript 9.27. Improved setup program. Image compression is turned on by default. Setup customization through setup.ini. Updated translations (Czech, French, Italian, Japanese, Polish, Spanish). However, it has not been tested. Fixes for systems without support for 8.3 file name creation.
Application crashes caused by DEVMODE structure was fixed. Fix for installer on systems where WMI is not available. More paper sizes in XPS mode. The AOM plug-in is optional; it is not officially supported. False positive virus detection removed. New Feature: Superimpose PDF documents. New macro for the full path of the output file. 2006-05-13
(1.0.0.18) The printer driver now works with all Ghostscript 8.x versions. Shows license type on about page. Temp files are now written to the temp folder below the application folder. 2008-12-24 (6.0.0.728) Error when saving a document to the root folder of a drive has been fixed. 2007-02-12 (3.0.0.125) Fix in detection of 32-bit Ghostscript on x64
systems. Silent MSI package. Updated translations (Hungarian, Estonian, Finnish, Arabic, Traditional Chinese, Greek, Catalan, Turkish). Many features are ignored in fast track mode. Non translated setup messages will be shown in English instead of showing up as blank. New IgnoreCopies setting to make only one copy of a document in the PDF
instead of the specified number in the print job. 2010-05-11 (7.1.0.1186) Smarttitle macro updated to filter out the [Compatibility Mode] tag in Microsoft Office. /NOHOMEPAGEICON command line switch for the setup program. 2010-02-08 (7.1.0.1140) New macro added to represent the application folder where gui.exe is installed. Misc. 2008-09-15
(6.0.0.684) ConfirmOverwrite setting is now supported in unattended mode. New installer switch: DPI to control the default resolution of the driver. New Feature: Remember last used file name. Improvements for non-interactive users. 2012-08-30 (8.4.0.1425) Improved embedding of fonts. Requires Ghostscript 8.50 or later. Registration of
comdlg32.ocx changed to avoid launching other Windows Installers. Much improved MSI files for distribution via Group Policy Objects. New /NOTOOLS switch for the installer can skip all dependencies. Auto detect Unicode or UTF-8 encoding of ini files. Fix: Both OnSuccess and OnError event handlers fired on error and success. Dialog control
identifiers have been modified to support hiding and disabling. GUI now supports creation of image formats. Many translations were updated. Monitor removes postscript file if the job is discarded. Hungarian translation completed. Resolution is now fixed to vectors when merging PDF background. Fixes file time stamp for attached files. New
Producer setting to set PDF Producer property. 2014-11-11 (10.9.0.2300) Works with Windows 10 Technical Preview. New setting watermarklayer is now supported. To navigate to the Bridge CC Extensions folder on your Mac: In the Finder window, choose Go > Go to Folder. New /PreserveDefaultPrinter command line switch for the setup program.
2013-10-08 (10.1.0.1871) New pagecount macro that inserts the number of pages in the print job. Support for Citrix MetaFrame. Translation updates (Traditional Chinese, Ukrainian, Dutch, Vietnamese, Latvian). Install the Adobe Output Module for Bridge CC 2017 version 7.0 Make sure that you have Bridge CC 2017 version 7.0 installed. The printer
can now extract text information from the print job. 2008-09-05 (6.0.0.664) Driver settings USERTEMP and USERDATA are no longer supported. Fonts look nicer in different screen resolutions. New context variables for Visual Basic Scripting (DocumentName, DocumentAuthor, DocumentCreationDate) Updated translations (Estonian, Romanian)
2010-03-08 (7.1.0.1159) Fix: Option dialog reported a runtime error 91 when closed. 2011-09-15 (7.2.0.1319) Fix for writing configuration files. New API method to print PDF documents to a specific Windows printer. Write status file if AfterPrintProgram or RunOnError fails. Color model setting to force RBB, CMYK, or Grayscale. Support for custom
license agreements. 2014-01-09 (10.2.0.2141) Improved color support in PDF/A-1b documents. Some print jobs looked different when coming from a shared printer. 2005-12-03 (1.0.0.16) Support for the settings: AfterPrintProgram, GhostscriptFolder, Output, SettingsProgram, ShowPDF and WorkArea. New setting 'textformat' controls if the text file
is formatted as Unicode or UTF8. New setting zoom is now supported by the user interface. Scripting engine is only initialized if macro files are present. Setting watermarksize is now obsolete use watermarkfontsize instead. Extended support for copy/paste of Chinese characters in PDF documents. Macro names in customgui setting. New setting
rememberlastfilename is now supported. Follow the instructions to install any updates. Download the appropriate file below by right-clicking (Windows) or Ctrl+clicking (Mac OS) and choosing to save the file. This folder contains: The Adobe Output Module folder The AdobeOutputModule.workspace file Copy the Adobe Output Module folder (not the
AOM_Package_[OS] folder) into the Bridge CC Extensions folder in the appropriate location: Windows: C:\Program Files\Common Files\Adobe\Bridge CC Extensions Mac OS X: /Library/Application Support/Adobe/Bridge CC Extensions In the Mac OS X folder path mentioned above, "Library" refers to the System Library, not the User Library. Fix for
temporary paths with Unicode characters. Performance tuning through GSGarbageCollection setting. 2015-08-25 (10.18.0.2455) Performance improvements to compensate for changes in Microsoft Security Essentials and EndPoint. If Scripting is not available then all VB Script macros will result in an empty string. New Feature: macro added for the
Output setting. The Adobe Output Module (AOM) plug-in works only with Bridge CC 2017 (version 7.0) and earlier releases. Registers .NET API for use in Visual Studio 2008. 2005-11-17 (1.0.0.10) Fix for selecting the correct file extension when using the Save As dialog. 2007-05-28 (3.0.0.211) Italian added as new language. 2008-09-14 (6.0.0.679)
Avoid detection as a virus for F-Secure users. 2015-09-28 (10.23.0.2529) 2015-09-15 (10.22.0.2525) User interface load time performance improvements. To navigate to the Bridge CC 2017 Extensions folder on your Mac: In the Finder window, choose Go > Go to Folder. New setting 'imagecompression=yes|no' added to control image compression.
2015-08-19 (10.15.0.2424) 2015-08-19 (10.14.0.2421) Create Microsoft Word documents from print jobs. We have a light weight distribution available at this site. Extra error handling added. This was disabled by a programming error. Arabic added as new language. 2008-12-20 (6.0.0.725) New defaults.ini file introduced to override default values. Fix
for encryption of PDF versions lower than 1.4. Default GUI timeout was changed from 0 to 10 minutes for a better merging experience. Solution 3 - Verify that you are not using an alias Mac OS: Navigate to Output module folder /Library/Application Support/Adobe/Bridge CC 2017 Extensions Make sure there is no arrow in the lower left of the icon
for the Adobe Output Module folder If there is an arrow, this folder is an alias. Fix: Encoding of setup texts fixes the display of garbage. (* only available in custom builds and bioPDF PDF Writer) Uninstall will remove all printers attached to the uninstalled port. Mapped printers are not shown in Citrix and Terminal Server sessions. 2008-09-19
(6.0.0.684-5) Translation updates (Brazilian Portuguese, Hungarian, Simplified Chinese). Fix for job names on printer queue when sending output to another printer. PrintToPrinter features fixed for running as a shared network printer. Fix for missing text on buttons on Windows 2000. 2008-02-04 (4.0.0.485) /PAPERSIZE installation switch added.
Status file now supports Unicode and UTF-8 encoding with descriptors. New macro creates an UTC timestamp. An arrow sign at the lower left of the icon (shown in the image below) indicates that the file or folder is an alias. (* only available in custom builds and bioPDF PDF Writer) 2008-03-27 (4.0.0.575) Problem with ini files written as Unicode has
been fixed. Fix for problem with creating folders on UNC paths. 2019-12-03 (11.11.0.2804) Support for monitors with high DPI. Better support for Adobe PageMaker. 2008-01-05 (4.0.0.462) German translation completed. Does not set the installed printer as default unless no default printer was selected by the user. 2013-07-30 (9.10.0.1629) Support
for Windows 8.1 Preview. New support for AES 128 and AES 256 bit encryption of PDF documents. 2009-10-01 (7.0.0.926) Official support for Windows 7. OwnerPassword and UserPassword settings now support macros. This folder contains: The Adobe Output Module folder The AdobeOutputModule.workspace file Copy the Adobe Output Module
folder (not the AOM_Package_[OS] folder) into the Bridge CC 2015 Extensions folder in the appropriate location: Windows: C:\Program Files\Common Files\Adobe\Bridge CC 2015 Extensions Mac OS X: /Library/Application Support/Adobe/Bridge CC 2015 Extensions In the Mac OS X folder path mentioned above, "Library" refers to the System Library,
not the User Library. 2015-03-18 (10.11.0.2338) New smarttitlefind and smarttitlereplace settings to control file name suggestion. 2014-05-17 (10.6.0.2267) Support for Ghostscript 9.14 (32-bit and 64-bit). New LicenseData setting to hold a base64 encoded license string. Resolution can be specified for background PDF documents in superimpose
operation. Support for PDF compatibility level 1.7. New macro. Forces that error meszsages are suppressed when the user is a service account ending with a $ sign. Option dialog now supports running program after processing a print job. Commercial version without Ghostscript dependency available on request. The problem was introduced in
version 4.0.0.564. New /SPOOLERCONTEXT setup command line switch for easier installation with services such as IIS. Ex. settings@MyPDFCreator.ini will hold settings for a printer named MyPDFCreator. 2007-02-12 (3.0.0.122) Fix in detection of Ghostscript on x64 systems. Macros can abort the process by setting the Abort to true in the context
dictionary. Updated translations (Norwegian, Finnish, British English, Australian English, Lithuanian). Polish translation completed. Setup program improved to solve problems on Windows XP Home. Better support for Unicode in PDF/A XMP structure. Locates Xpdf and Ghostscript Lite packs outside the printer's application folder. New Esperanto
translation. New image compression settings (ImageCompressionLevel, ImageCompressionType, ImageCompressionQuality) for commercial distiller. Fixes problem with save as dialog selection being lost. 2008-01-16 (4.0.0.463-5) Translations updated (Hebrew, Japanese, Portuguese). 2019-07-11 (11.10.0.2761) New code for printing/redirecting the
PDF to another printer. 2011-04-07 (7.2.0.1304) Minor fixes since the beta version 7.2.0.1288 Modifications in the parameter exchange with customized GUI. AOM is not shipped with Bridge CC November 2016 (version 7.0) and earlier releases. More information about Ghostscript is available here. Updated translations (Croatian, Hebrew, Thai,
Turkish, Romanian, Greek). However, in some offline scenarios this is not possible. Translations updated (Polish, Italian). Advanced printer setting 'TrueType Font Download Option' now defaults to 'Outline'. Fix in config.exe to allow mixed case parameter values. 2007-07-05 (3.0.0.270) Retries moving destination file if it is locked by Antivirus software
for some time after generation. New registry settings 'Disable Impersonation', 'Application Data', 'Common Application Data' and 'Local Application Data' were added to improve printing from IIS and sharing the printer on the network. New /SHARE switch for the setup program to enable network sharing on print servers. 2015-08-27 (10.19.0.2457)
Microsoft.NET API encryption changed to support Dynamics NAV server on Windows 10. Fix for problem with text file output. Fix of problem with strange characters overlaying the finished PDF document. Greek added as new language. UK English language was added. Install the Adobe Output Module for Bridge CC 2015 version 6.3.x If you are
using Bridge CC 2015, download the appropriate file below by right-clicking (Windows) or Ctrl+clicking (Mac OS) and choosing to save the file. Added translation (Thai). 2016-08-29 (10.25.0.2552) Shows an error if you are trying to use the program as a PDF reader. Additional GUI improvements and localization. 2008-11-01 (6.0.0.702) The Save As
dialog now selects the output format based on the file name extension. Implementation of the DeviceList setting was improved. Improved port monitor reports errors to the event log. 2008-01-14 (4.0.0.463-3) 2008-01-13 (4.0.0.463-2) 2008-01-09 (4.0.0.463) Bulgarian translation completed. Fixed copying sample configuration files for custom printer
names. 2009-11-29 (7.1.0.1078) Improved handling of Unicode in GUI. Major rewrite of the printer driver. Support for debug mode in print monitor. New runonce command line parameter for gui.exe to force the use of a specific runonce settings file. Australian English language was added. 2010-03-07 (7.1.0.1157) New macro context variables
ErrorNumber, ErrorDescription, and ErrorSource. Updated translations (Arabic, Bosnian, Bulgarian, Dutch, Hebrew, Hungarian, Kannada, Lithuanian, Slovak) 2010-05-30 (7.1.0.1195) RunOnError registry setting added for error handling by the printer port. 2007-10-14 (3.0.0.352) Supports printing in Window Vista Internet Explorer running in
protected mode. 2021-02-21 (12.1.0.2890) Improved email functionality. Now you are ready to print from your other applications. 2015-08-23 (10.17.0.2428) Another false positive virus detection removed. Trial message is now a link for more information. 2020-10-03 (12.0.0.2872) Multiple printer ports to support concurrent printing. This is done to
make the programming interface more robust to mixed case in the target settings. Support for Ghostscript 9.53. 2008-09-16 (6.0.0.684-3) Translation updates (Serbian, Polish). Enhanced special character support in PDF passwords. 2014-08-01 (10.7.0.2277) Fixes problems with detection of installed Ghostscript. 2008-04-20 (5.0.0.594) Translations
added (Bosnian, Slovenian). Supported Operating Systems Microsoft Windows Server 2019 Microsoft Windows Server 2016 Microsoft Windows 10 (32 and 64 bit) Microsoft Windows 8 & 8.1 (32 and 64 bit) Microsoft Windows Server 2012 & 2012 R2 (32 and 64 bit) Microsoft Windows 7 (32 and 64 bit) Microsoft Windows Server 2008 & 2008 R2 (32
and 64 bit) Microsoft Windows Vista (32 and 64 bit) Microsoft Windows Server 2003 & 2003 R2 (32 and 64 bit) Microsoft Windows XP (32 and 64 bit) PDF Converter The printer uses the Ghostscript PDF converter. Translation updates (Italian, Romanian, Bulgarian, Swedish, French, Slovenian, Czech). The setup program can detect if you have a valid
PDF converter installed. New Feature: The output name in the settings.ini can contain macro names such as and , which will be substituted with the actual document name and current date when the PDF document is generated. 2009-01-13 (6.0.0.741) Experimental support for Windows 7 beta. Print to printer after output is created. New ICC profile
for better PDF/A compatibility. macro was changed from special folder CSIDL_DESKTOP to CSIDL_DESKTOPDIRECTORY. 2007-12-30 (4.0.0.459) Error 53 when merging with other documents has been fixed. Fix for running as a shared printer. New installer switch: AdvancedFeatures to enable or disable the advanced features of the PostScript
driver. 2007-11-26 (4.0.0.432) Watermarks now use TrueType fonts instead of Ghostscript fonts. The use of cmd /c for starting external programs was removed to allow command lines containing & and other special chars Improvement of the smarttitle macro. 2010-01-18 (7.1.0.1136) New wipemethod=3pass setting is now supported to do a 3 pass
wipe of temporary files created during PDF or image creation. New setup command line switch ORIGINALDRIVER to keep the setup from changing the driver. Additional SFTP signature algorithms. Support for Windows 8 Consumer Preview 64 bit (x64). Updated translations for Traditional Chinese, Greek, Russian, and Slovak 2017-03-10
(11.1.0.2600) Click on balloon notification to open PDF location. New macro. New settings to upload the result to FTP or SFTP servers. New setting 'textfilename' to save the content of the print job as text. These are the packages you should put on your distribution point and include in your GPO: The order of installation does not matter. Install option
to override default TrueTypeDownload setting. The user's advanced settings are now reset during installation. 2011-02-23 (7.2.0.1288) You will now get multiple copies of the document inside the same PDF if you set the number of copies in the printing dialog. Fixes in the printer driver. Additional architectural paper sizes ARCH E1 and ARCH E1
Half. Internal API functions isolated in PdfInternal interface. Dependency on the Microsoft Scripting Dictionary component was removed. Catalan translation completed. Updated translations (Hungarian, Traditional Chinese, Simplified Chinese, Russian, Portuguese, Swedish, German, Spanish, Italian, Serbian). Ini files no longer have the printer name
in their file name. Support for different PDF versions in PDF/A creation. Fixes loading of option sets with different device settings. Setting watermarktransparency is now obsolete use watermarkcolor instead. Discontinued support for Windows 8 Developer Preview. CustomGui setting now holds a command line instead of only the executable. VB
Script macros now require the ALLOWEXECUTE flag to run when the macrodir setting is used. 2007-04-11 (3.0.0.186) Fix: Error message removed when installing on XP 64 bit. In Windows Explorer, navigate to the \Users\[user name]\AppData\Roaming\Adobe\Bridge CC 2017\Workspaces folder. Support for Windwos 8 RTM was added. New setting
to control confirmations of folder creation. Fix for SFTP upload. Fix: Specifying folders as default file names has been improved. Save the file in a location you can remember, such as your desktop. Improvements for PDF Printer redistribution and customization. New setting 'Orientation' to control fixed page orientation. Fix: Patching PDFA XMP data
structure when using non western code pages. This feature is meant for a redistribution scenario. 2008-03-13 (4.0.0.564) Support for programmatic creation of JPEG, TIFF, and PNG image files instead of PDF documents. Traditional Chinese as new language. CONFIG program to change settings. New Zoom setting to determine the initial zoom factor
when a document is viewed. Superimpose operation allows Encapsulated Postscript as input in addition to PDF files. User interface is now DPI aware. 2019-02-17 (11.9.0.2735) Fixed overflow (error 6) problem. Postscript added as output type. 2013-07-15 (9.9.0.1621) Image compression is turned off by default for better quality. More work done on
the Visual Basic Script macros. 2012-04-10 (8.2.0.1406) New settings EmbedAllFonts and SubsetFonts. Allows appending with the same file name as the output even if the append file doesn't exist. Mac OS: Close Bridge. 2013-04-19 (9.8.0.1599) Improved setup for Windows XP machines. Print from Metro style applications in Windwos 8. Download
version 12.2.0.2902 with commercial distiller This version has a fix for the use of color models. For help documentation, see Create a PDF contact sheet in Output workspace. They are now written to settings.ini in the data folder below the application folder. Updated translations (Brazilian Portuguese, Slovenian, Ukrainian, British English, Australian
English, Polish, Japanese). Microsoft.NET API was introduced. 2012-03-06 (8.2.0.1394) Support for Windows 8 Consumer Preview 32 bit (x86). New uploadpermissions setting to control permissions with FTP upload. Swedish translation completed. Problem with diagonal strange black dots should be solved. Multiple option sets can now be defined.
Open the resulting AOM_Package_Mac, AOM_Package_Win64, or AOM_Package_Win32 folder. Bulgarian translation completed. Translation updates (Russian). 2012-09-21 (9.0.0.1437) Support for Windows Server 2012. Select the workspace switcher arrow at the top of Bridge's window and choose Output. Possible issues and solutions Solution This
error is displayed when you have an older version of the AOM installed. Samples of global.ini, defaults.ini, and settings.ini are installed. Setting usedefaultauthor is default set to yes. More image formats are now supported (BMP, JPEG, PCX, PDF, PNG, TIFF). New UseThumbs setting to show thumbnail pictures of pages when a document is viewed.
2016-03-07 (10.24.0.2543) HTTP/HTTPS upload feature added. 2007-08-23 (3.0.0.309) Specific background images for all pages. 2009-12-12 (7.1.0.1080) Digitally signed setup program. Ini files settings.ini, runonce.ini, global.ini, defaults.ini, and user.ini have changed location. 2009-10-09 (7.0.0.928) Setup detects if gslite.exe is outdated. Support for
Ghostscript 8.70.
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